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1 

1.1 CAUTION  

INTRODUCTION 

The GPS system is operated by the government of the United States, which is solely responsible for its accuracy and 
maintenance. Although the GPS 15x is a precision electronic NAVigation AID (NAVAID), any NAVAID can be 
misused or misinterpreted, and therefore become unsafe. Use these products at your own risk. To reduce the risk, 
carefully review and understand all aspects of these Technical Specifications before using the GPS 15x. When in 
actual use, carefully compare indications from the GPS to all available navigation sources including the information 
from other NAVAIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before continuing 
navigation. 

FCC Compliance 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio frequency energy and may cause 
harmful interference to radio communications if not installed and used in accordance with the instructions. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one of the following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and the receiver. 
• Connect the equipment into an outlet that is on a different circuit from the receiver. 
• Consult the dealer or an experienced radio/TV technician for help. 

 
This product does not contain any user-serviceable parts. Repairs should only be made by an authorized Garmin 
service center. Unauthorized repairs or modifications could result in permanent damage to the equipment, and void 
your warranty and your authority to operate this device under Part 15 regulations. 
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1.2 LIMITED WARRANTY 
This Garmin product is warranted to be free from defects in materials or workmanship for one year from the date of 
purchase. Within this period, Garmin will, at its sole option, repair or replace any components that fail in normal 
use. Such repairs or replacement will be made at no charge to the customer for parts or labor, provided that the 
customer shall be responsible for any transportation cost. This warranty does not apply to: (i) cosmetic damage, such 
as scratches, nicks and dents; (ii) consumable parts, such as batteries, unless product damage has occurred due to a 
defect in materials or workmanship; (iii) damage caused by accident, abuse, misuse, water, flood, fire, or other acts 
of nature or external causes; (iv) damage caused by service performed by anyone who is not an authorized service 
provider of Garmin; or (v) damage to a product that has been modified or altered without the written permission of 
Garmin. In addition, Garmin reserves the right to refuse warranty claims against products or services that are 
obtained and/or used in contravention of the laws of any country. 

This product is intended to be used only as a travel aid and must not be used for any purpose requiring precise 
measurement of direction, distance, location or topography. Garmin makes no warranty as to the accuracy or 
completeness of map data in this product. 

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES EXPRESS, IMPLIED, OR STATUTORY, INCLUDING ANY LIABILITY ARISING 
UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, 
STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY 
VARY FROM STATE TO STATE. 

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR ANY TRAFFIC 
FINES OR CITATIONS, WHETHER RESULTING FROM THE USE, MISUSE OR INABILITY TO USE THE 
PRODUCT OR FROM DEFECTS IN THE PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY 
TO YOU. 

Garmin retains the exclusive right to repair or replace (with a new or newly-overhauled replacement product) the 
device or software or offer a full refund of the purchase price at its sole discretion. SUCH REMEDY SHALL BE 
YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY. 

To obtain warranty service, contact your local Garmin authorized dealer or call Garmin Product Support for 
shipping instructions and an RMA tracking number. Securely pack the device and a copy of the original sales 
receipt, which is required as the proof of purchase for warranty repairs. Write the tracking number clearly on the 
outside of the package. Send the device, freight charges prepaid, to any Garmin warranty service station.  

Online Auction Purchases: Products purchased through online auctions are not eligible for warranty coverage. 
Online auction confirmations are not accepted for warranty verification. To obtain warranty service, an original or 
copy of the sales receipt from the original retailer is required. Garmin will not replace missing components from any 
package purchased through an online auction. 

International Purchases: A separate warranty may be provided by international distributors for devices purchased 
outside the United States depending on the country. If applicable, this warranty is provided by the local in-country 
distributor and this distributor provides local service for your device. Distributor warranties are only valid in the area 
of intended distribution. Devices purchased in the United States or Canada must be returned to the Garmin service 
center in the United Kingdom, the United States, Canada, or Taiwan for service. 

Garmin’s Marine Warranty Policy: Certain Garmin Marine products in certain areas have a longer warranty 
period and additional terms and conditions. Go to www.garmin.com/support/warranty.html for more details and to 
see if your product is covered under Garmin’s Marine Warranty Policy. 

 

http://www.garmin.com/support/warranty.html�
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1.3 OVERVIEW 
The GPS 15x sensor board is designed for a broad spectrum of OEM (Original Equipment Manufacturer) system 
applications. Based on the proven technology found in other Garmin GPS receivers, the GPS 15x tracks multiple 
satellites at a time while providing fast time-to-first-fix, precise navigation updates, and low power consumption. 
The GPS 15x includes the capability of Wide Area Augmentation System (WAAS) differential GPS. 

The GPS 15x requires minimal additional components to be supplied by an OEM or system integrator. A minimum 
system must provide the GPS with a source of power, an active GPS antenna, and a clear view of the GPS satellites. 
The system may communicate with the GPS 15x through its 3.3 Vdc CMOS-level serial port. The asynchronous 
serial port interface is UART (Universal Asynchronous Receiver-Transmitter) compatible polarity. The GPS 15x 
stores data such as satellite orbital parameters, last-known position, and date and time in the battery backed up 
SRAM. End-user interfaces, such as keyboards and displays, are the responsibility of the application designer. 

1.4 FEATURES 
• GPS receiver tracks and uses multiple satellites for fast, accurate positioning and velocity estimates. 

• Compact, rugged design ideal for applications with minimal space.   

• May be remotely mounted in an out-of-the-way location.   

• User initialization is not required. Once installed, this device automatically produces navigation data. 

• On-board backup battery to maintain the non-volatile SRAM and real-time clock for up to 21 days. 

• Provision for external power to maintain the charge on the backup battery. 

• Configurable parameters include expected position, current time and date, and preferred position fix type (2D, 
3D, or automatic). 
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1.5 TECHNICAL SPECIFICATIONS 
Specifications are subject to change without notice. 

1.5.1 Physical Characteristics 
1.5.1.1 Size 
0.940 × 1.690 × 0.309 in. (23.88 × 42.93 × 7.84 mm) 

1.5.1.2 Weight 
0.26 oz. (7.37 g) 

1.5.1.3 Available Connector Options 
GPS 15x-F: 6-pin LIF flex connector, 1 millimeter pitch. For use with common 1mm pitch, 6-conductor flex 

cable, available as Garmin Part Number 310-00040-00. This flex cable mates with common 1mm 
pitch, 6-pin flex connector, such as Garmin Part Number 330-00346-06 or Molex Part Number 
52793-0690. Refer to the Molex Web site at www.molex.com. 

GPS 15x-W: 6-pin JST connector, 1 millimeter pitch; mating wire harness included. (Garmin Part Number 325-
00118-00). The connector housing used on this harness is equivalent to JST Part Number SHR-
06V-S-B. The 6-wire crimp socket is equivalent to JST Part Number SSH-003T-P0.2. Refer the 
JST Web site at www.jst.com. 

1.5.1.4 Antenna Connector  
The GPS 15x provides a MCX female connector for connection to an active GPS antenna. The antenna should be 
terminated in MCX male. A suitable antenna is Garmin GA 25 MCX (Garmin Part Number 010-10702-00). Other 
antennas that are terminated in male BNC connectors may be adapted using a Garmin MCX to BNC Adapter Cable 
(Garmin Part Number 010-10121-00).   

1.5.2 Electrical Characteristics 
1.5.2.1 Input Voltage 
From 3.0 Vdc to 3.5 Vdc regulated, with less than ±50 mV peak-to-peak voltage ripple 

1.5.2.2 Input Current  
75 mA peak, 66 mA nominal 

1.5.2.3 CMOS Serial Output Levels 
0 Vdc to 2.8 Vdc (Asynchronous Serial, UART Compatible Polarity) 

1.5.2.4 GPS Receiver Sensitivity 
-185 dBW minimum 

1.5.3 Environmental Characteristics 
• Operating Temperature: From -22°F to 176°F (from -30°C to +80°C  

• Storage Temperature: From -40°F to 194°F (from -40°C to +90°C 

http://www.molex.com/�
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1.5.4 GPS Performance 
1.5.4.1 Receiver  
WAAS enabled GPS receiver continuously tracks and uses multiple satellites to compute and update your position. 

1.5.4.2 Acquisition Times 
• Reacquisition: Less than 2 seconds 

• Hot: Approx. 1 second (all data known) 

• Warm: Approx. 38 seconds (initial position, time, and almanac known; ephemeris unknown) 

• Cold: Approx. 45 seconds 

1.5.4.3 Update Rate 
1 second default; NMEA 0183 output interval configurable from 1 to 900 seconds in 1-second increments 

1.5.4.4 Accuracy 
• GPS Standard Positioning Service (SPS) 

Position: < 15 meters, 95% typical (100 meters with Selective Availability on) 
Velocity: 0.1 knot RMS steady state 

• DGPS (WAAS) 
Position: <3 meters, 95% typical 
Velocity: 0.1 knot RMS steady state 

• Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 3g dynamics 

1.5.5 Interfaces 
1.5.5.1 GPS 15x Electrical Characteristics 
• CMOS level output for interfacing directly to a UART on the host. 

• Factory setting is 4800 baud. User-selectable baud: 4800, 9600, 19200, 38400. 
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1.5.6 Antenna Specifications 
The active antenna used with the GPS 15x should have the following specifications: 
Gain: Antenna should provide between 10 dB to 35 dB net gain between the antenna feed 

point and the connection to the GPS 15x. All amplifier gains, filter losses, cable 
losses, etc. must be considered when calculating the gain.  

RF Connection: GPS 15x RF Connection: MCX Female connector (on the GPS 15x board) 
Antenna Connection: MCX Male connector (on the end of the antenna cable) 

Garmin Antenna: GA 25 MCX (Garmin Part Number 010-10702-00) provides the required MCX 
Male connector. Other Garmin antennas terminated in a BNC Male connector may 
also be used if a Garmin MCX to BNC Adapter Cable (Garmin Part Number 010-
10121-00) is used. Place the MCX to BNC Adapter Cable between the connector on 
the end of the antenna cable and the connector on the GPS 15x. 

Noise Figure/Gain: The total noise on the external antenna must be ≤ 7 dB with a gain between 10 dB 
and 35 dB.  Refer to the table below.   

 

Should be properly biased by your choice of: 

Table 1: Gain vs. SNR for Given Noise Figure 

Power from on-board source: 3.3 Vdc, the voltage you supply to Vin, through an on-board  ~10 Ohm current 
limiting resistance. The antenna must not draw more than 60 mA. 

Power from external source: From 4.0 Vdc to 8.0 Vdc bias through the series combination of an on-board 
~10 Ohm current limiting resistance and a Schottky diode. The antenna must not 
draw more than 60 mA. The external source of antenna bias voltage should not have 
any noise in the GPS band (centered at 1.57542 GHz). 
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2 
The GPS 15x-F uses a six-contact flex circuit LIF connector. The GPS 15x-W uses a six-pin JST connector (mating 
wire harness included). (See section 

GPS 15X WIRE DESCRIPTIONS AND WIRING DIAGRAMS 

1.5.1.3 for details.) 

2.1 GPS 15X WIRE DESCRIPTIONS 
GPS 
15x  

Pin # 
Signal Name Description 

1 BACKUP POWER This input provides external power to maintain the battery-backed 
SRAM and real-time clock. This enables the user to provide backup 
power if needed for longer than the on-board rechargeable battery 
will provide (roughly 21 days). Input voltage must be between +2.8 
and +3.4 Vdc. 

2 GROUND Power and Signal Ground 
3 POWER Regulated +3.3 Vdc input. Peak operating current is 75mA. Nominal 

operating current is 66mA. 
4 PORT 1 DATA OUT Asynchronous Serial Output. 

CMOS compatible output designed to interface directly with a 
UART on a host system or host microprocessor. Provides serial data 
which is formatted per “NMEA 0183, Version 2.30”. The baud rate 
is set during production to 4800, but other rates are available. 

5 PORT 1 DATA IN First Asynchronous Serial Input. 
CMOS compatible input designed to interface directly with a UART 
on a host system or host microprocessor. Input voltage range of 0 < 
V < 3.3. 

6 RF BIAS This input allows the user to externally apply an RF bias to the active 
antenna. By default, the unit will use an internal voltage to power the 
active antenna. If an external voltage greater than the internal voltage 
of the center pin of the antenna (between 4.0 Vdc and 8.0 Vdc) is 
detected at this input, the GPS 15x will automatically changes to the 
external voltage. The antenna must not draw more than 60 mA.   

Table 2: GPS 15x Wire Descriptions 
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2.2 GPS 15X WIRING DIAGRAMS 

 
Figure 1: Computer Serial Port Interconnection 

 
Figure 2: PDA Serial Port Interconnection 

 

 

Figure 3: Basic NMEA 0183 Device Interconnection 
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3 MECHANICAL CHARACTERISTICS & MOUNTING  

 

 

Figure 4: GPS 15x-F Dimensions 

 
Figure 5: GPS 15x-W Outline Drawing 
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4 
The interface protocol design of the GPS 15x is based on the National Marine Electronics Association’s NMEA 
0183 ASCII interface specification. This standard is fully defined in NMEA 0183, Version 2.30. Copies may be 
obtained from NMEA, 

GPS 15X SOFTWARE INTERFACE 

www.nmea.org.  

In addition to the standard NMEA 0183 sentences, the GPS 15x may also be configured to transmit information over 
their serial interface using NMEA 0183 compliant Garmin proprietary sentences. These proprietary sentences begin 
with the characters, “$PGRM”, instead of the characters “$G” that are typical of the standard NMEA 0183 
sentences. The characters “$P” indicate that the sentence is a proprietary implementation and the characters and 
“GRM” indicate that it is Garmin’s proprietary sentence. The character (or characters) that follow the characters 
“$PGRM” uniquely identifies that particular Garmin proprietary sentence. 

It is also possible to configure the GPS 15x to transmit binary data information over their serial interface. See 
Appendix B: Garmin Binary Output Format for details.  

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by the GPS 
15x.  

4.1 RECEIVED NMEA 0183 SENTENCES 
The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in the 
configuration sentence indicate no change in the particular configuration parameter. All sentences received by the 
GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return (0D hexadecimal) and 
line feed (0A hexadecimal). The checksum *hh is used for parity checking data and is not required, but is 
recommended for use in environments containing high electromagnetic noise. It is generally not required in normal 
PC environments. When used, the parity bytes (hh) are the ASCII representation of the upper and lower nibbles of 
the exclusive-or (XOR) parity, computed over all of the characters between the “$” and “*” characters, non-
inclusive. The hex representation must be a capital letter, such as 3D instead of 3d. Sentences may be truncated by 
<CR><LF> after any data field and valid fields up to that point will be acted on by the sensor. 

4.1.1 Almanac Information (ALM) 
The $GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the event of non-
volatile memory loss or after storing longer than six months without tracking GPS satellites. 

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF> 

<1> Total number of ALM sentences to be transmitted by the GPS sensor during almanac download. 
This field can be null or any number when sending almanac to the GPS sensor. 

<2> Number of current ALM sentence. This field can be null or any number when sending almanac 
to the GPS sensor. 

<3> Satellite PRN number, 01 to 32 
<4> GPS week number 
<5> SV health, bits 17–24 of each almanac page 
<6> Eccentricity 
<7> Almanac reference time 
<8> Inclination angle 
<9> Rate of right ascension 

<10> Root of semi major axis 
<11> Omega, argument of perigee 
<12> Longitude of ascension node 
<13> Mean anomaly 
<14> af0 clock parameter 
<15> af1 clock parameter 

http://www.nmea.org/�
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4.1.2 Sensor Initialization Information (PGRMI) 
The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used for 
satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the satellite acquisition 
process. If there are no errors in the sentence, it will be echoed upon receipt. If an error is detected, the echoed 
PGRMI sentence will contain the current default values. Current PGRMI defaults (with the exception of the 
Receiver Command, which is a command rather than a mode) can also be obtained by sending $PGRMIE to the 
GPS sensor. 

$PGRMI,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF> 

<1> Latitude, ddmm.mmm format (leading zeros must be transmitted) 
<2> Latitude hemisphere, N or S 
<3> Longitude, dddmm.mmm format (leading zeros must be transmitted) 
<4> Longitude hemisphere, E or W 
<5> Current UTC date, ddmmyy format 
<6> Current UTC time, hhmmss format 
<7> Receiver Command, A = Auto Locate, R = Unit Reset 

4.1.3 Sensor Configuration Information (PGRMC) 
The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration 
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this 
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC sentence will contain 
the current default values. Current default values can also be obtained by sending $PGRMCE to the GPS sensor. 

$PGRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF> 

<1> Fix mode, A = Automatic, 3 = 3D exclusively 
<2> Altitude above/below mean sea level, -1500.0 to 18000.0 meters 
<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must contain valid 

values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A: Earth Datum List for a list of 
earth datum and the corresponding earth datum index. 

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters resolution) 
<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10-9 resolution) 
<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution) 
<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution) 
<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution) 
<9> Differential mode, A = Automatic (output DGPS data when available, non-DGPS otherwise), D = 

Differential exclusively (output only differential fixes) 
<10> NMEA 0183 Baud rate, 3 = 4800, 4 = 9600, 5 = 19200, 8 = 38400 
<11> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<12> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<13> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<14> Dead reckoning valid time 1 to 30 seconds 

All configuration changes take effect after receipt of a valid value except baud rate. Baud rate changes take effect on 
the next power cycle or an external reset event. 
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4.1.4 Additional Sensor Configuration Information (PGRMC1) 
The $PGRMC1 sentence provides additional information used to configure the GPS sensor operation. Configuration 
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this 
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC1 sentence will contain 
the current default values. Current default values can also be obtained by sending $PGRMC1E to the GPS sensor. 

$PGRMC1,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF> 

<1> NMEA 0183 output time 1 to 900 (sec). Not applicable to GPS 18x-5Hz, which always outputs data at 5 Hz 
(200 ms) 

<2> Garmin Binary Output, 1 = Off, 2 = On. 
<3> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<4> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<5> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<6> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<7> NMEA 0183 version, 1 = version 2.20 (factory default), 2 = version 2.30 
<8> DGPS WAAS mode, W = WAAS Enabled, N = WAAS Disabled, A = Automatic, R = RTCM (DO NOT 

USE – not supported on the GPS 15x.) 
<9> Power Save Mode, P = Power Save mode, N = Normal 

<10> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<11> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<12> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<13> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<14> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<15> Low Velocity Threshold, 1 = Off, 2 = On 

Configuration changes take effect immediately, with the exception of Garmin Binary Output, which takes effect on 
the next power cycle or a reset event. Send the sentence “$PGRMI,,,,,,,R” to command a reset (refer to section 4.1.2 
Sensor Initialization Information (PGRMI)). If the GPS sensor is in the binary data mode, it is necessary to send the 
following eight-byte data stream to temporarily change the data format to NMEA 0183. Then follow by sending a 
PGRMC1 sentence that turns off the Garmin Binary Output format: 

10 0A 02 26 00 CE 10 03 (Hexadecimal) 

4.1.5 Output Sentence Enable/Disable (PGRMO) 
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following sentences 
are enabled at the factory: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT. 

$PGRMO,<1>,<2>*hh<CR><LF> 

<1> Target sentence description (for example, PGRMT, GPGSV, etc.) 
<2> Target sentence mode, where: 

 0 = Disable specified sentence,  
 1 = enable specified sentence,  
 2 = Disable all output sentences,  
 3 = Enable all output sentences (except GPALM),  
 4 = Restore factory default output sentences 

The following notes apply to the PGRMO input sentence: 

If the target sentence mode is “2” (Disable all), “3” (Enable all), or “4” (Restore defaults), the target sentence 
description is not checked for validity. In this case, an empty field is allowed (for example, $PGRMO,,3), or the 
mode field may contain from 1 to 5 characters. 

If the target sentence mode is “0” (Disable) or “1” (Enable), the target sentence description field must be an 
identifier for one of the sentences that can be output by the GPS sensor. 

If either the target sentence mode field or the target sentence description field is not valid, the PGRMO sentence will 
have no effect. 

$PGRMO,GPALM,1 will cause the GPS sensor to transmit all stored almanac information. All other NMEA 0183 
sentence transmission will be suspended temporarily. 
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$PGRMO,,G will cause the COM port to change to Garmin Data Transfer format for the duration of the power 
cycle. The Garmin mode is required for GPS 15x series product software updates. 

4.2 TRANSMITTED NMEA 0183 SENTENCES 
The subsequent paragraphs define the sentences that can be transmitted on COM 1 by the GPS sensor. 

4.2.1 Sentence Transmission  
Sentences are transmitted with respect to the user selected baud rate. 

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence descriptions) at a 
periodic rate based on the user selected baud rate and user selected output sentences. The GPS sensor will transmit 
the selected sentences contiguously. The length of the transmission can be determined by the following equation and 
Tables 2 and 3: 

     total characters to be transmitted 
 length of transmission     =            --------------------------------------------- 
     characters transmitted per second 

Sentence Output by Default? Maximum Characters 
GPRMC ✔ 74 
GPGGA ✔ 82 
GPGSA ✔ 66 
GPGSV ✔ 70 
PGRME  35 
GPGLL  44 
GPVTG  42 
PGRMV  32 
PGRMF  82 
PGRMB  40 
PGRMID  82 
PGRMM   
PGRMT Once per minute 50 

Baud 

Table 3: NMEA 0183 Output Sentence Order and Size 

Characters per Second 
4800 480 
9600 960 
19200 1920 
38400 3840 

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values in the 
table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The factory set 
defaults result in a once per second transmission at the NMEA 0183 specification transmission rate of 4800 baud. 

Table 4: Characters per Second for Available Baud Rates 

4.2.2 Transmitted Time 
The GPS sensor outputs Coordinated Universal Time (UTC) date and time of day in the transmitted sentences. 
Before the initial position fix, the on-board clock provides the date and time of day. After the initial position fix, the 
date and time of day are calculated using GPS satellite information and are synchronized with the closest UTC 
second boundary. 

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and correct the 
transmitted date and time of day. The transmitted date and time of day for leap second correction follow the 
guidelines in “National Institute of Standards and Technology Special Publication 432 (Revised 1990)” (for sale by 
the Superintendent of Documents, U.S. Government Printing Office, Washington, D.C., 20402, U.S.A.). 



 

190-00266-02 GPS 15x Technical Specifications  Rev. B 
Page 14 

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s) of the 
day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The GPS sensor 
would have transmitted this information for the leap second added December 31, 1998 as follows: 

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69 

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67 

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67 

$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66 

If a negative leap second should be required, one second will be deleted at the end of some UTC month. The minute 
containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not transmit the time of 
day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed. 

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69 

$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A 

$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69 

4.2.3 Global Positioning System Almanac Data (ALM) 
Almanac sentences are not normally transmitted. Send the GPS sensor a $PGRMO,GPALM,1 command to initiate 
almanac transmission. Upon receipt of this command, the GPS sensor will transmit available almanac information 
on GPALM sentences. During the transmission of almanac sentences, other NMEA 0183 data output is suspended 
temporarily. 

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF> 

<field information> can be found in section 4.1.1 Almanac Information (ALM). 

4.2.4 Global Positioning System Fix Data (GGA) 
$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,M,<10>,M,<11>,<12>*hh<CR><LF> 

<1> UTC time of position fix, hhmmss format 
<2> Latitude, ddmm.mmmm format (leading zeros will be transmitted)  
<3> Latitude hemisphere, N or S 
<4> Longitude, dddmm.mmmm format (leading zeros will be transmitted)  
<5> Longitude hemisphere, E or W 
<6> GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 = 

Differential GPS (WAAS) fix available, 6 = Estimated 
<7> Number of satellites in use, 00 to 12 (leading zeros will be transmitted) 
<8> Horizontal dilution of precision, 0.5 to 99.9 
<9> Antenna height above/below mean sea level, -9999.9 to 99999.9 meters 

<10> Geoidal height, -999.9 to 9999.9 meters 
<11> Null (Differential GPS) 
<12> Null (Differential Reference Station ID) 

4.2.5 GPS DOP and Active Satellites (GSA) 
$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>*hh<CR><LF> 

<1> Mode, M = Manual, A = Automatic 
<2> Fix type, 1 = not available, 2 = 2D, 3 = 3D 
<3> PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be 

transmitted) 
<4> Position dilution of precision, 0.5 to 99.9 
<5> Horizontal dilution of precision, 0.5 to 99.9 
<6> Vertical dilution of precision, 0.5 to 99.9 
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4.2.6 GPS Satellites in View (GSV) 
$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>*hh<CR><LF> 

<1> Total number of GSV sentences to be transmitted 
<2> Number of current GSV sentence 
<3> Total number of satellites in view, 00 to 12 (leading zeros will be transmitted) 
<4> Satellite PRN number, 01 to 32 (leading zeros will be transmitted) 
<5> Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted) 
<6> Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted) 
<7> Signal to noise ratio (C/No) 00 to 99 dB (leading zeros will be transmitted) 

Note: Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites per sentence. 
Additional satellites in view information must be sent in subsequent bursts of NMEA 0183 data. These fields will be 
null if unused. 

4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC) 
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF> 

<1> UTC time of position fix, hhmmss format 
<2> Status, A = Valid position, V = NAV receiver warning 
<3> Latitude, ddmm.mmmm format (leading zeros will be transmitted)  
<4> Latitude hemisphere, N or S 
<5> Longitude, dddmm.mmmm format (leading zeros will be transmitted)  
<6> Longitude hemisphere, E or W 
<7> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted) 
<8> Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted) 
<9> UTC date of position fix, ddmmyy format 

<10> Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted) 
<11> Magnetic variation direction, E or W (westerly variation adds to true course) 
<12> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D = 

Differential, E + Estimated, N = Data not valid 

4.2.8 Track Made Good and Ground Speed (VTG) 
$GPVTG,<1>,T,<2>,M,<3>,N,<4>,K,<5>*hh<CR><LF> 

<1> True course over ground: 000 to 359 degrees (leading zeros will be transmitted) 
<2> Magnetic course over ground: 000 to 359 degrees (leading zeros will be transmitted) 
<3> Speed over ground: 000.0 to 999.9 knots (leading zeros will be transmitted) 
<4> Speed over ground: (leading zeros will be transmitted) 
<5> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, 

D = Differential, E = Estimated, N = Data not valid 

4.2.9 Geographic Position (GLL) 
$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF> 

<1> Latitude, ddmm.mmmm format (leading zeros must be transmitted) 
<2> Latitude hemisphere, N or S 
<3> Longitude, dddmm.mmmm format (leading zeros must be transmitted) 
<4> Longitude hemisphere, E or W 
<5> UTC time of position fix, hhmmss format 
<6> Status, A = Valid position, V = NAV receiver warning 
<7> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, 

D = Differential (WAAS), E = Estimated, N = Data not valid 
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4.2.10 Estimated Error Information (PGRME) 
$PGRME,<1>,M,<2>,M,<3>,M*hh<CR><LF> 

<1> Estimated horizontal position error (HPE), 0.0 to 999.9 meters 
<2> Estimated vertical position error (VPE), 0.0 to 999.9 meters 
<3> Estimated position error (EPE), 0.0 to 999.9 meters 

4.2.11 GPS Fix Data Sentence (PGRMF) 
$PGRMF,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF> 

<1> GPS week number (0 to 1023) 
<2> GPS seconds (0 to 604799) 
<3> UTC date of position fix, ddmmyy format 
<4> UTC time of position fix, hhmmss format 
<5> GPS leap second count 
<6> Latitude, ddmm.mmmm format (leading zeros must be transmitted) 
<7> Latitude hemisphere, N or S 
<8> Longitude, dddmm.mmmm format (leading zeros must be transmitted) 
<9> Longitude hemisphere, E or W 

<10> Mode, M = Manual, A = Automatic 
<11> Fix type, 0 = no fix, 1 = 2D fix, 2 = 3D fix 
<12> Speed over ground, 0 to 1851 kilometers/hour 
<13> Course over ground, 0 to 359 degrees, true 
<14> Position dilution of precision, 0 to 9 (rounded to nearest integer value) 
<15> Time dilution of precision, 0 to 9 (rounded to nearest integer value) 

4.2.12 Programmable Device ID (PGRMID) 
The Garmin Proprietary sentence $PGRMID gives the device owner the flexibility of naming each sensor device 
with a custom text value. 

$PGRMID,<1>,<2>,<3>*hh<CR><LF> 

<1> ID Configuration Command, S = Set ID, C = Clear ID, E = Echo ID 
<2> User Defined ID (Maximum number of characters = 58) 
<3> Garmin Unit ID (Predefined and unique to each device) 

4.2.13 Map Datum (PGRMM) 
The Garmin Proprietary sentence $PGRMM gives the name of the map datum currently in use by the GPS sensor. 
This information is used by the Garmin MapSource real-time plotting application. 

$PGRMM,<1>*hh<CR><LF> 

<1> Name of map datum currently in use (variable length field, for example, “WGS 84”) 

4.2.14 Sensor Status Information (PGRMT) 
The Garmin Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor. This 
sentence is transmitted once per minute regardless of the selected baud rate. 

$PGRMT,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF> 

<1> Product, model and software version (variable length field, for example, “GPS 15x VER 2.05”) 
<2> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<3> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<4> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<5> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<6> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<7> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
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<8> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<9> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 

4.2.15 3D Velocity Information (PGRMV) 
$PGRMV,<1>,<2>,<3>*hh<CR><LF> 

<1> True east velocity, -514.4 to 514.4 meters/second 
<2> True north velocity, -514.4 to 514.4 meters/second 
<3> Up velocity, -999.9 to 999.9 meters/second 

4.2.16 DGPS Beacon Information (PGRMB) 
$PGRMB,<1>,<2>,<3>,<4>,<5>,K,<6>,<7>,<8>*hh<CR><LF> 

<1> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<2> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<3> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<4> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<5> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<6> No Effect (This field is not used on the GPS 15x and is included only for compatibility with other models.) 
<7> DGPS fix source: W = WAAS, N = No DGPS fix available 
<8> Currently selected DGPS mode as specified by the PGRMC1 sentence of Section 4.1.4: A = Automatic 

(factory default), W = WAAS only, R = RTCM only (RTCM is not supported on the GPS 15x and should 
not be used), N = None (No DGPS enabled) 

 



 

190-00266-02 GPS 15x Technical Specifications  Rev. B 
Page 18 

The following is a list of the Garmin GPS 15x Earth datum indices and the corresponding earth datum name 
(including the area of application): 

APPENDIX A: EARTH DATUM LIST 

0 ADINDAN–Ethiopia, Mali, Senegal, Sudan 

9 AUSTRALIAN GEODETIC 1984–Australia, Tasmania Island 

10 ASTRO DOS 71/4–St. Helena Island 

11 ASTRONOMIC STATION 1952–Marcus Island 

12 ASTRO B4 SOROL ATOLL–Tern Island 

13 BELLEVUE (IGN)–Efate and Erromango Islands 

14 BERMUDA 1957–Bermuda Islands 

15 BOGOTA OBSERVATORY–Colombia 

16 CAMPO INCHAUSPE–Argentina 

17 CANTON ASTRO 1966–Phoenix Islands 

18 CAPE CANAVERAL–Florida, Bahama Islands 

19 CAPE–South Africa 

20 CARTHAGE–Tunisia 

21 CHATHAM 1971–Chatham Island (New Zealand) 

22 CHUA ASTRO–Paraguay 

23 CORREGO ALEGRE–Brazil 

24 DJAKARTA (BATAVIA)–Sumatra Island (Indonesia) 

25 DOS 1968–Gizo Island (New Georgia Islands) 

26 EASTER ISLAND 1967–Easter Island 

27 EUROPEAN 1950–Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy, 
Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland 

28 EUROPEAN 1979–Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland 

29 FINLAND HAYFORD 1910–Finland 

30 GANDAJIKA BASE–Republic of Maldives 

31 GEODETIC DATUM 1949–New Zealand 

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936–England, Isle of Man, Scotland, Shetland Islands, 
Wales 

33 GUAM 1963–Guam Island 

34 GUX 1 ASTRO–Guadalcanal Island 

35 HJORSEY 1955–Iceland 

36 HONG KONG 1963–Hong Kong 

37 INDIAN–Bangladesh, India, Nepal 

38 INDIAN–Thailand, Vietnam 

39 IRELAND 1965–Ireland 

40 ISTS O73 ASTRO 1969–Diego Garcia 

41 JOHNSTON ISLAND 1961–Johnston Island 

42 KANDAWALA–Sri Lanka 

43 KERGUELEN ISLAND–Kerguelen Island 
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44 KERTAU 1948–West Malaysia, Singapore 

45 L.C. 5 ASTRO–Cayman Brac Island 

46 LIBERIA 1964–Liberia 

47 LUZON–Mindanao Island 

48 LUZON–Phillippines (excluding Mindanao Island) 

49 MAHE 1971–Mahe Island 

50 MARCO ASTRO–Salvage Islands 

51 MASSAWA–Eritrea (Ethiopia) 

52 MERCHICH–Morocco 

53 MIDWAY ASTRO 1961–Midway Island 

54 MINNA–Nigeria 

55 NORTH AMERICAN 1927–Alaska 

56 NORTH AMERICAN 1927–Bahamas (excluding San Salvador Island) 

57 NORTH AMERICAN 1927–Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras, 
Nicaragua) 

58 NORTH AMERICAN 1927–Canal Zone 

59 NORTH AMERICAN 1927–Canada (including Newfoundland Island) 

60 NORTH AMERICAN 1927–Caribbean (Barbados, Caicos Islands, Cuba, Dominican Republic, Grand 
Cayman, Jamaica, Leeward Islands, Turks Islands) 

61 NORTH AMERICAN 1927–Mean Value (CONUS) 

62 NORTH AMERICAN 1927–Cuba 

63 NORTH AMERICAN 1927–Greenland (Hayes Peninsula) 

64 NORTH AMERICAN 1927–Mexico 

65 NORTH AMERICAN 1927–San Salvador Island 

66 NORTH AMERICAN 1983–Alaska, Canada, Central America, CONUS, Mexico 

67 NAPARIMA, BWI–Trinidad and Tobago 

68 NAHRWAN–Masirah Island (Oman) 

69 NAHRWAN–Saudi Arabia 

70 NAHRWAN–United Arab Emirates 

71 OBSERVATORIO 1966–Corvo and Flores Islands (Azores) 

72 OLD EGYPTIAN–Egypt 

73 OLD HAWAIIAN–Mean Value 

74 OMAN–Oman 

75 PICO DE LAS NIEVES–Canary Islands 

76 PITCAIRN ASTRO 1967–Pitcairn Island 

77 PUERTO RICO–Puerto Rico, Virgin Islands 

78 QATAR NATIONAL–Qatar 

79 QORNOQ–South Greenland 

80 REUNION–Mascarene Island 

81 ROME 1940–Sardinia Island 

82 RT 90–Sweden 
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83 PROVISIONAL SOUTH AMERICAN 1956–Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela 

84 SOUTH AMERICAN 1969–Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay, 
Peru, Venezuela, Trinidad and Tobago 

85 SOUTH ASIA–Singapore 

86 PROVISIONAL SOUTH CHILEAN 1963–South Chile 

87 SANTO (DOS)–Espirito Santo Island 

88 SAO BRAZ–Sao Miguel, Santa Maria Islands (Azores) 

89 SAPPER HILL 1943–East Falkland Island 

90 SCHWARZECK–Namibia 

91 SOUTHEAST BASE–Porto Santo and Madeira Islands 

92 SOUTHWEST BASE–Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores) 

93 TIMBALAI 1948–Brunei and East Malaysia (Sarawak and Sabah) 

94 TOKYO–Japan, Korea, Okinawa 

95 TRISTAN ASTRO 1968–Tristan da Cunha 

96 User defined earth datum 

97 VITI LEVU 1916–Viti Levu Island (Fiji Islands) 

98 WAKE-ENIWETOK 1960–Marshall Islands 

99 WORLD GEODETIC SYSTEM 1972 

100 WORLD GEODETIC SYSTEM 1984 

101 ZANDERIJ–Surinam 

102 CH-1903–Switzerland 

103 Hu-Tzu-Shan 

104 Indonesia 74 

105 Austria 

106 Potsdam 

107 Taiwan–modified Hu-Tzu-Shan 

108 GDA–Geocentric Datum of Australia 

109 Dutch 
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In binary output mode, the GPS 15x will transmit packets once per second. The record contains primarily post-
process information such as position and velocity information. 

APPENDIX B: GARMIN BINARY OUTPUT FORMAT 

To turn this record on, use the $PGRMC1 NMEA 0183 sentence as described in Section 4. Refer to the Garmin 
Device Interface Specification found in the Garmin Device Interface SDK for details on how to form and parse 
Garmin packets, available at www.garmin.com/support/commProtocol.html. 

Note that the satellite data information is also enabled when the position record is enabled.  

Records sent over RS232 begin with a delimiter byte (10 hex). The second byte identifies the record type (33 hex for 
a position record and 72 hex for a satellite data record). The third byte indicates the size of the data. The fourth byte 
is the first byte of data. The data is then followed by a checksum byte, a delimiter byte (10 hex), and an end-of-
transmission character (03 hex). Additionally, any DLEs (0x10) that appear between the delimeters are escaped with 
a second DLE. There is sample code at the end of this section that will strip off the DLEs and ETXs. 

RS232 Packet: 

- 0x10    (DLE is first byte) 

- 0x##   (Record ID – single byte) 

- 0x##   (Number of data bytes – single byte) 

- data bytes  (See descriptions below) 

- 0x##   (2’s complement of the arithmetic sum of the bytes between the delimiters) 

- 0x10   (DLE) 

- 0x03   (ETX is last byte) 

The data bytes of each packet contain the record specified by the record ID. A description of each record follows. 
 

The satellite data has a record ID of 0x72 with 84 (0x54) data bytes. The data bytes contain data for 12 satellites as 
described below.  

Satellite Data Record 

typedef struct 
 { 
 uint8 svid; //space vehicle identification (1–32 and 33–64 for WAAS) 
 uint16  snr;  //signal-to-noise ratio  
 uint8 elev; //satellite elevation in degrees 
 uint16 azmth; //satellite azimuth in degrees 
 uint8 status; //status bit-field  
 } cpo_sat_data; 
 

The status bit field represents a set of Booleans described below: 

Bit Meaning when bit is one (1) 
0 The unit has ephemeris data for the specified satellite. 
1 The unit has a differential correction for the specified satellite. 
2 The unit is using this satellite in the solution. 

This pattern is repeated for 12 satellites for a total of 12 × 7 bytes = 84 (0x54) bytes. 

http://www.garmin.com/support/commProtocol.html�
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RS-232 Packet for the Satellite Record: 

- 0x10    (DLE is first byte) 

- 0x72   (Record ID – single byte) 

- 0x54   (Number of data bytes – single byte) 

- 12 cpo_sat_data records: 

- 0x##   (2’s complement of the arithmetic sum of the bytes between the delimiters) 

- 0x10   (DLE) 

- 0x03   (ETX is last byte) 

 

 
Position Record 

The Position Record has a record identifier of  
typedef struct 
 { 
 float alt; 
 float epe; 
 float eph; 
 float epv; 
 int fix; 
 double gps_tow; 
 double lat; 
 double lon; 
 float lon_vel; 
 float lat_vel; 
 float alt_vel; 
 float msl_hght; 
 int leap_sec; 
 long grmn_days; 
 } cpo_pvt_data; 
 
alt  Ellipsoid altitude (meters) 
epe  Estimated position error (meters) 
eph  Position error, horizontal (meters) 
epv  Position error, vertical (meters) 
fix  0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential; 
 6 and greater = not defined 
gps_tow  GPS time of week (sec) 
lat Latitude (radians)  
lon Longitude (radians)  
lon_vel Longitude velocity (meters/second) 
lat_vel Latitude velocity (meters/second) 
alt_vel Altitude velocity (meters/second) 
msl_hght Height (mean sea level) (meters) 
leap_sec UTC leap seconds 
grmn_days Garmin days (days since December 31, 1989) 
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DLE and ETX bytes: 
Sample C code to receive the two records should filter DLE and ETX bytes as described below: 
typedef enum 
    { 
    DAT, 
    DLE, 
    ETX 
    } rx_state_type; 
 
/* Declare and initialize static variables */ 
static char in_que[ 256 ]; 
static int in_que_ptr = 0; 
static rx_state_type rx_state = DAT; 
 
. 
. 
. 
 
void add_to_que( char data ) 
{ 
#define DLE_BYTE 0x10 
#define ETX_BYTE 0x03 
 
if ( rx_state == DAT ) 
    { 
    if ( data == DLE_BYTE ) 
        { 
        rx_state = DLE; 
        } 
    else 
        { 
        in_que[ in_que_ptr++ ] = data; 
        } 
    } 
else if ( rx_state == DLE ) 
    { 
    if ( data == ETX_BYTE ) 
        { 
        rx_state = ETX; 
        } 
    else 
        { 
        rx_state = DAT; 
        in_que[ in_que_ptr++ ] = data; 
        } 
    } 
else if ( rx_state == ETX ) 
    { 
    if ( data == DLE_BYTE )  
        { 
        rx_state = DLE; 
        } 
    } 
 
if ( in_que_ptr > 255 ) 
    { 
    in_que_ptr = 0; 
    } 
} 
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In certain cases, you may need to change the default baud rate of your Garmin GPS receiver while in Garmin mode. 
Follow these steps to temporarily change the baud rate.  

APPENDIX C: CHANGING THE BAUD RATE IN GARMIN MODE 

Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for details on how to 
form and parse Garmin packets, available at www.garmin.com/support/commProtocol.html. 

1. Turn off all requests by transmitting packet:  

id = IOP_RQST_DATA (0x1C) 

data = 0 (16-bit unsigned integer ) 

2. The GPS unit will respond by sending a packet with id = IOP_ACK_BYTE (0x06) 

3. After you receive the above packet, transmit packet: 

id = IOP_BAUD_RQST_DATA (0x30) 

data = baud rate to change to (32-bit unsigned integer; for example, 38400) 

4. The GPS unit will respond by sending a packet:  

id = IOP_BAUD_ACPT_DATA (0x31) 

data = highest acceptable baud rate closest to what was requested  
(32-bit unsigned integer; for example, 38361 decimal) 

5. Determine the actual baud rate value from the data sent in step 4. This value will be within +/- 5% of the actual 
baud rate. (For example, the GPS unit might send a baud rate of 38361, which correlates to a baud rate of 
38400).  

6. If the baud rate in step 5 is acceptable, transmit packet:  

id = IOP_ACK_BYTE (0x06) 

data = IOP_BAUD_ACPT_DATA (0x31) 

7. Sleep for a small amount of time, about 100 milliseconds, to make sure the packet in (6) was successfully 
transmitted to the GPS unit. 

8. Close the current connection to the GPS unit and immediately open a new connection with the new baud rate 
obtained in step 5. 

9. Immediately after establishing a connection, transmit packet: 

id = IOP_CMND_DATA (0x0A) 

data = IOP_ACK_PING (0x3A) 

10. The GPS will respond by sending a packet: 

id = IOP_ACK_BYTE (0x06) 

data = IOP_CMND_DATA (0x0A) 

11. After you receive the above packet, transmit the same packet in step 9 again. 

id = IOP_CMND_DATA (0x0A) 

data = IOP_ACK_PING (0x3A) 

12. The GPS will respond again with the same packet in step 10. 

id = IOP_ACK_BYTE (0x06) 

data = IOP_CMND_DATA (0x0A) 

13. The baud rate has been successfully changed upon receiving the above packet. If the GPS unit does not receive 
these two IOP_CMND_DATA packets within two seconds, it will reset its baud rate to 9600. 

http://www.garmin.com/support/commProtocol.html�
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Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 15x as the output of 
a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial BallPoint Mouse. 
This causes the cursor to move erratically about the display, clicking, right-clicking, double-clicking, and dragging 
and dropping displayed items as it goes. On Windows 2000 and Windows XP, you may not experience the problem 
if you wait until after the computer is booted before connecting the GPS 15x to the serial communications port. This 
problem is not specific to the GPS 15x. Any NMEA 0183 device connected to a Windows computer’s serial port is 
likely to cause this problem. Below are several possible solutions to this problem.  

APPENDIX D: GPS 15x WINDOWS SERIAL MOUSE ISSUE 

If you wish to use a different navigation software application with your GPS 15x, you will need to de-select the 
Garmin Binary Output option that is discussed in Solution 3 below. 

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. This solution 
assumes that you do not need to use a Serial BallPoint mouse with your computer. When erratic mouse movements 
occur, follow the steps below.  

1. Unplug the DB9 connector. 

2. Right-click the My Computer icon on your desktop, and select Properties to open Device Manager. 

3. Go to the hardware tab of the resulting pop-up window, and click on the Device Manager button.  

4. Right-click on Serial BallPoint Mouse, and choose the option to Disable (NOT uninstall) this device. 

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the operating 
system is completely booted up and running. Every time you use the GPS 15x, you will need to start the computer 
and operating system before making the connection between the GPS 15x and the computer. This solution usually 
works on Windows 2000 and Windows XP computers.  

Solution 3: Change the default output of the GPS 15x so that it does not automatically send NMEA 0183 data to the 
computer (change the default configuration to enable Garmin Binary Output). Use the Garmin Sensor Configuration 
Software, named SNSRXCFG.EXE, provided on the Web site to enable “Garmin Binary Output.” To download the 
software, start at www.garmin.com/oem, select the GPS 15x, and then select Software. 

NOTE: By enabling “Garmin Binary Output,” the device will no longer appear as a NMEA 0183 device to your 
computer. As a result, mapping applications that expect to hear NMEA 0183 data will not recognize your GPS 15x 
until you re-enable the NMEA 0183 output, disabling the Garmin Binary Output in the process. 

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor 
Configuration Software application. 

After the Sensor Configuration Software is installed and running on your computer, follow the steps below to 
change the default data output of the GPS 15x.  

1. Select the GPS 15x from the list of sensors, and click 
OK. The Sensor Configuration Software opens with 
the default configuration file for the GPS 15x, as 
shown on the next page.  

2. Select Config > Switch to NMEA Mode (or press the 
F10 key). 

3. Select Comm > Setup to open the Comm Setup 
Window. 

http://www.garmin.com/oem�
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4. Select the serial port to which the GPS 15x is 
connected. Select Auto to have the 
program automatically determine the baud 
rate, or select Manual to manually select 
the baud rate of the GPS 15x. Click OK 
when done.  

 

5. Click the Connect icon , or select 
Comm > Connect to connect to the GPS 
15x.  

6. To view the current programming of the 
GPS 15x, select Config > Get 
Configuration from GPS (or press the F8 
key). The current programming of the GPS 
15x is displayed in the window, as shown 
on the previous page.  

7. Open the Sensor Configuration Window 
by pressing the F6 key or selecting Config > 
Sensor Configuration.  

8. Place a check mark in the box next to 
Garmin Binary Output to change the GPS 
15x to Garmin Mode. The unit will keep 
this change in the programming until you 
change it again in the software.  

Note: Selecting Config > Switch to 
Garmin Mode (or pressing the F11 key) only 
changes the unit to work in Garmin Mode until 
power is cycled through the unit again. For a 
more permanent change, refer to step 8 above.   

9. Click OK.  

10. When you are ready to upload the changes 
into the GPS 15x, select Config > Send 
Configuration to GPS (or press the F9 
key). The new configuration is then loaded 
into the GPS 15x.  

11. You may disconnect and close the 
software when finished. The software 
configuration can also be saved for future 
reference.  

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor 
Configuration Software application. 
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SNSRXCFG configures the GPS sensors based on user-selected parameters. Some application features include the 
ability to download GPS sensor configuration, maintain different configurations in files, and perform GPS sensor 
configurations quickly with the use of one function key.   

APPENDIX E: SENSOR CONFIGURATION SOFTWARE 

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when using the 
software to configure your Garmin sensor.   

Downloading the Sensor Configuration Software 
The Garmin Sensor Configuration Software (SNSRXCFG.exe) is available from the Garmin Web site. To 
download the software, start at http://www.garmin.com/oem, select the GPS 15x, and then select Software. The 
Garmin Sensor Configuration Software (SNSRXCFG.exe) is included in the software update download. 

Selecting a Model 
After opening the program (SNSRXCFG.exe), the following screen appears. Select the radio button next to the type 
of Garmin sensor you are configuring and click OK.   

Connecting to the Sensor 
After selecting the type of sensor, the following window opens. This is 
the Main Interface Screen for the program.   

To configure your sensor, you must first connect to the sensor.   

1. Select Config > Switch to NMEA Mode (or press the F10 key). 

2. Select Comm > Setup to open the Comm Setup Window. 

3. Select the Serial Port to which the sensor is 
connected. Select Auto to have the program 
automatically determine the Baud Rate, or 
select Manual to manually select the Baud Rate 
of the GPS 15x. Click OK when done.   

4. Click the Connect icon , or select Comm > 
Connect.   

5. To view the current programming of the sensor, 
select Config > Get Configuration from GPS 
(or press the F8 key). The current programming 
of the sensor is displayed in the window shown 
to the right.   

http://www.garmin.com/oem�
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File Menu 
The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work like most 
Windows-based programs.   

Comm Menu 
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and disconnect 
from the sensor.   

Setup: Opens the Comm Setup Window, shown to the left. Select the Serial 
Port to which the sensor is connected from the drop-down list. Then select 
Auto (the program determines the baud rate on its own) or Manual (you 
then enter the baud rate) for the Baud Rate entry.   

Connect: Select Connect to connect to the sensor to change or view the 
configuration.   

Disconnect: Select Disconnect to disconnect from the sensor.   

Config Menu 
The Config (Configuration) Menu allows you 
configure the sensor as it is connected. 

Sensor Configuration (F6): Opens the 
Sensor Configuration Window, shown to the 
right. Many of the fields in this window 
should be left alone. Please refer to the 
beginning of this manual for clarification 
about some of these fields. For the most part, 
this window is used to enter a new Latitude, 
Longitude, and Altitude for the sensor. This is 
especially helpful when you are programming 
the sensor for use in a particular geographic 
location.   

Resetting the Unit (Reset Unit) performs a 
reset on the unit, much like cycling the power.     

Resetting the non-volatile memory (Reset 
NonVol) will clear all of the data from the 
non-volatile memory.   

NMEA Sentence Selections (F7): Displays 
the NMEA Sentence Selections Window. If 
the sentence is enabled, a check mark appears 
in the box to the left of the sentence name. 
Click the box to enable or disable to the 
sentence. 

Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The programming is then 
displayed in the Main Interface Window.   

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor.   

Switch to NMEA Mode (F10): Switches the unit to NMEA 0183 Mode. The sensor must be in NMEA 0183 Mode 
in order to establish a serial connection to this software (see “Connecting to the Sensor” above).   

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.  
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View Menu 
The View Menu allows you to view the NMEA 0183 sentences transmitted by the sensor. You can also customize 
how the program looks by showing and hiding the Toolbar and Status Bar.   

Help Menu 
The Help Menu displays the software version and copyright information.  



 

 

 

 

For the latest free software updates (excluding map data) throughout the life of your  
Garmin products, visit the Garmin Web site at www.garmin.com. 
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